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Language Arts/Business Writing

Grades:  11-12

Down to Business
Writing and Posting a Multimedia Résumé

Tools

Kit software:  Inspiration Other:  Computers; the

Internet; AppleWorks; EdView;

a Web page editor such as

Netscape Composer

Optional:  A digital camcorder;

a digital camera; a scanner;

iMovie

Project Duration

Seven to eight class sessions

Introduction

Besides being critical to any job search, résumé writing is a form of self-expression, a means of

capturing personal history and identity on a single page. Creating their first résumés can be a

revelation for students, helping them see their strengths or even focus their efforts in school. How

can group collaboration help high school students, with little or no formal job experience, present

their skills and experience in a résumé? How can we leverage technology to help students translate

what they know about themselves into résumé form and to make their résumés available to

potential employers?

Project Overview

After an introduction to the form and function of résumés, students prepare to write résumés of

their own by writing down basic information about themselves, including activities and interests. In

small groups, they assist each other in identifying potentially valuable skills, and then in pairs they

use Inspiration to create “Résumé Planning Maps.” Using résumés that others have written for

guidance, students draft their own résumés in AppleWorks. Finally, students return to their groups

for peer review of their drafts, incorporate suggestions in a revision, and then post their résumés,

complete with multimedia elements, on the Internet.
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Phase 1: Learning about résumés

Begin by asking your students what they know about résumés. What is a résumé? What are

résumés for? Explain that by conveying your history, skills, and personality, your résumé is a way of

introducing yourself to potential employers.

Look at one or more sample résumés (see the Resources section) with your class, noting the kinds

of information included and the different ways this information can be organized. Introduce basic

concepts, including targeting and chronological versus functional résumés.

Ask students to complete the “Who Am I? Worksheet,” which helps them prepare to write their

own résumés. (See the “Who Am I? Worksheet” template on the kit Web site.)

Phase 2: Identifying skills and strengths

Ask students to form small groups of four. Working from their completed “Who Am I?

Worksheets,” each student in turn summarizes his or her interests, strengths, activities, and work

experience for the rest of the group. After each oral summary, the group works to identify the job

skills inherent in that student’s activities and experiences, brainstorming a list of at least five skills

that the student can enter in his or her printed “Skills Worksheet.” (See the “Skills Worksheet”

template on the kit Web site.)

Individually, students complete their “Skills Worksheets.” Then students pair up to help each other

plan their résumés. Using the Inspiration “Résumé Planning Map,” students create visual maps

showing, for each student, all the possible components of their résumés, organized by category.

Students print their “Résumé Planning Maps” in both diagram and outline form, and export the

outline form as text for use in Phase 3. (See the “Résumé Planning Map” template on the kit

Web site.)

Phase 3: Finding models and writing résumés

Groups reconvene and use EdView and other search engines to search the Web for examples of

résumés that others have created. (They can also search library resources, if available.) They

identify the format of each example as either chronological, functional, or combination, and discuss

the strengths and weaknesses of each example as a model for their own résumés.

In AppleWorks, students (working individually) write first drafts of their résumés, using words and

phrases from the résumé outlines they exported as text in Phase 2, and referring to one or more of

the example résumés as models.

With drafts written, students come back into their groups and go through each member’s résumé

in turn, offering suggestions for improvement which might include wording changes, structural

changes, or additions. Based on the peer review comments, students revise and print their

résumés.
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Phase 4: Creating multimedia résumés for the Web

Students collect and create multimedia elements they can include with their résumés when they

are posted on the Internet. These may include digital images of the student, scanned images of

awards or artwork, desktop movies of student activities created with a digital camcorder and iMovie,

and digital samples of student work.

Returning to their groups, students cooperate in building résumé Web sites for each group

member. Working in Netscape Composer (or a similar Web page editor) they paste in the text

from their AppleWorks résumés, format the text, and insert the multimedia elements they have

collected. Students then post their résumé Web sites on the Internet, where they can be viewed

by family members, potential employers, college admissions officers, and scholarship granting

organizations.

Technical and Facilitation Tips

Facilitation Tips: Phase 1

m Some students may wonder why they should write a résumé if they won’t be entering the job

market anytime soon. Explain to them that the process of writing a résumé can be of most value

to those who aren’t looking for work, and may not have put much thought into their future

careers at all. By writing a résumé now, students can take stock of where they are now, and plan

where they want to be later. Résumé writing is especially useful for students who plan to apply to

college, since much of the information and self-promotion required for college applications is

the same.

m To introduce your students to résumés, show them several representative examples, either by

using an overhead projector or by providing each student with a set of copies. Résumé samples

can be found on the Web or in any résumé-writing book (See the Resources section). Try to

include some résumés of high school-aged people.

m Traditionally, résumé formats are either chronological or functional. A chronological format

presents work experience by date, while a functional résumé lists skills and then describes

activities and accomplishments that document those skills. A common compromise between

these two is called a combination résumé, which lists skills and also work experience by date.

Students with little or no work experience will probably fare best with a functional or combination

format. However, there are almost infinitely many ways to structure a résumé, and students

should pursue whichever format fits their situation best. For more information about the

structure and content of chronological and functional résumés, see the Background

Information section.

m In practice, good résumés are “targeted,” that is, designed to express suitability for a particular

job. If students have jobs in mind to which they would like to target their résumés, encourage

them to do so. Those with no job targets in mind can create more general résumés, reflecting a

broad range of skills.

m This phase will occupy most of a class session. Students can finish filling out their worksheets

outside of class, if necessary.
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Facilitation Tips: Phase 2

m In this creative brainstorming phase, help students identify and list the skills inherent in their

activities by providing a few examples: A person who describes herself as “bossy” could translate

this into “strong managerial skills.” Baby-sitting involves skills such as scheduling, planning,

managing, and problem solving.

m Encourage students to compare their “Who Am I? Worksheets” and see if they can expand on

their own.

m During this phase, students should begin to consider the résumé format they might want to use.

Do they have enough work experience that they can consider a chronological format? Would

they prefer to highlight certain skill sets with a functional format?

m Students interested in targeting their résumés will want to focus mainly on the skills and

experience that pertains to their job objective.

m This phase will occupy two class sessions.

Tech Tips: Phase 2

m In Inspiration, toggle between Diagram and Outline format by clicking the Diagram or Outline

icon on the left of the toolbar at the top of the Inspiration window. Alternatively, choose Diagram

or Outline from the View menu.

m Students can easily export their work in Inspiration as a text file. This file, which will contain the

categories, skill lists, and other information in the “Résumé Planning Map,” can be opened in

AppleWorks in Phase 3, when it is time to write a first draft of the résumé. To export the

“Résumé Planning Map” as text, follow these steps:

1 Display the “Résumé Planning Map” in Outline format.

2 Choose Export from the File menu.

3 Click Plain Text, then click Save.

4 Give the file a recognizable filename, navigate to and select the folder where you want to

save it, and click Save.

Facilitation Tips: Phase 3

m Many of the résumés that students find either on the Internet or in books will not be appropriate

models for student résumés because they are centered around extensive work histories. Help

students locate résumé samples representing younger people, or provide them with these

yourself.
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m Experiences and activities should be described in phrases instead of complete sentences, using

strong “action verbs” whenever possible. Action verbs add energy and convey industry and

competence. The following is a list of active verbs appropriate for résumés.

achieved established planned

analyzed evaluated prepared

advised executed presented

arranged explained programmed

assembled founded promoted

assigned formulated reduced

assisted gathered researched

authored generated resolved

budgeted guided reorganized

calculated implemented selected

coached improved solved

collected initiated scheduled

communicated instructed supervised

completed invented taught

coordinated launched transformed

determined lobbied utilized

developed managed wrote

devised operated

directed organized

m Choosing appropriate headings is a key aspect of organizing information in a résumé. Some

common headings your students might want to consider are objective, summary, summary of

qualifications, highlights, skills, experience, work experience, volunteer experience, summer

employment, honors and awards, education, related course work, computer skills, languages,

and interests. Students can and should tailor the headings they use to the information they want

to present.

m The listing of references is not recommended. However, students may choose to mention that

references are available.

m Remind students that filling up the page is not the goal. Some “white space” is desirable,

because it makes the résumé easier to read and digest.

m In general, students’ résumés should not exceed 200 words. Résumés should also be limited to

one side of one page.

m Once the résumé draft is written, students should look to sample résumés for ideas on graphic

presentation. Graphic elements they might want to consider are bullets for lists, horizontal lines

to delineate sections, bold type, font size, and italics. In general, these formatting steps should

be saved for last.
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m When reviewing each other’s work, students can ask the following questions about each

résumé:

m Does the information fit the format?

m Are work experiences and other accomplishments described using action verbs?

m Has every opportunity been taken to showcase desirable traits and skills?

m Is the résumé readable and attractive?

m When groups get together to edit each other’s work, remind them to be constructive in their

criticisms. The idea is not to decide who has the best résumé, but to help each person make

their résumé as strong as possible.

m If students draft and revise their résumés as homework, this phase will require two class

sessions: one for discussion of examples and one for peer review.

Facilitation Tips: Phase 4

m Encourage students to share technology resources (digital cameras and camcorders and

scanners) and to help each other use them.

m Students’ résumé Web sites can range from single pages with a few images to multi-page sites

with complex designs containing a variety of multimedia elements. Where their Web sites fall in

this continuum will depend on students’ technical expertise, their experience with Web page

design, available digital imaging technology, and time.

m If students want to include many multimedia elements and examples of their work in their Web

sites, the sites should be broken up into several linked pages. If this is the case, students should

be encouraged to plan the architecture of their sites before beginning to construct them (a task

best accomplished with Inspiration).

m At the end of the project, encourage your students to keep updating their résumés (both the

AppleWorks version and the Internet version) with each new accomplishment. A résumé is a

living document; if kept updated, it will be ready whenever needed.

m This phase will occupy two or three class sessions.

Tech Tips: Phase 4

m For help using iMovie, visit the “Desktop Movies in Education” Web site.

m Students creating Web sites with multiple pages, complex designs, or movies may want to refer

to the following Step-by-Step Cards: “Adding Links in Netscape Composer,” “Setting Web Page

Properties With Netscape Composer,” “Working with Tables in Netscape Composer,” and

“Adding Sound and Movies in Netscape Composer.”

m Students can publish their résumés on the Web using an Apple iTools account. For detailed

instructions, see the Step-by-Step Cards “Setting Up an iTools Account” and “Publishing Your

Web Pages With iTools.”
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Outcomes

After completing this project, students will be able to

m create a résumé that summarizes their skills and experience

m describe the difference between a functional and chronological résumé format

m create a Web page using a Web page editor

In addition, students will have

m taken stock of the their strengths and experiences and framed them in terms of marketable

skills

m practiced their ability to conduct research using various sources

m developed skills in written communication for business

m gained confidence and skill in their abilities to work in groups

m practiced their skills of constructive criticism

m completed a résumé that they can use in applying for college, summer jobs, internships, and

so on

m learned skills or acquired knowledge relating to each of the state and national standards referred

to in the Project Standards section

Project Standards

From the Secondary Language Arts & Social Studies Web site, you can identify select state

curriculum standards and national educational technology standards that correlate to this student

project. To locate these standards, go to the kit Web site and click the Curriculum button. Locate

and open this student project and click the “Project Standards” button.

Assessment Suggestions

In Phase 3, each student’s résumé can be assessed based on the following criteria:

m information is organized under appropriate headings

m activities and jobs are described using action verbs

m information is appropriate to the job objective, if one has been specified

m the résumé is attractive, easy to read, and free of errors

In Phase 4, each student’s résumé Web site can be evaluated based on the criteria listed above,

plus criteria such as the following:

m multimedia elements add valuable information about the student

m text and multimedia elements are arranged in a logical manner

m multimedia elements are identified with labels or captions

m links between pages are worded and arranged so that it is easy to navigate around the site

(applies only to sites of more than one page)
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In addition, each student’s résumé (AppleWorks, HTML, or both) can be placed in his or her

electronic portfolio.

Preparation

m Gather several sample résumés that you can use to introduce your students to the project. Try

to include examples of chronological, functional, and combination formats, as well as résumés of

high school-aged people. If using an overhead projector, copy these samples onto

transparencies. Otherwise, make a set of paper copies for each student.

m Review and print any of the Step-by-Step Cards that students may find helpful during this

project. These include “Getting Started With Inspiration,” “Searching the Internet With

EdView,” “Using Netscape Composer,” “Adding a Graphic to a Composer Web Page,” and

“Moving Back and Forth Between Netscape Composer and Navigator.”

m Check out résumé-writing books from the school or local library in advance. These books

typically contain a collection of sample résumés, which students will find useful for inspiration

and guidance during Phase 3.

Resources

Internet

Adventures in Education—High School Students Get a Job

http://www.adventuresineducation.org/text/HighSchool/hs_job.htm

Desktop Movies in Education

http://www.apple.com/education/dv/

EdView

http://www.edview.apple.com

JobHunters Bible’s Résumé Writing Page by Richard Bolles

http://www.jobhuntersbible.com/resumes/resumes.shtml

JobStar: Caifornia Résumés and Cover Letters

http://jobstar.org/tools/resume/index.htm

Proven Résumés.com

http://www.provenresumes.com/

Résumé Writing Tips for High School Students

http://www.provenresumes.com/reswkshps/hsrespg1.html

SnagAJob.com—Sample High School Résumés

http://www.snagajob.com/job_tips/highschool.asp

Victoria Human Resource Centre—Sample High School Student Résumé

http://www.bc.hrdc-drhc.gc.ca/victoria/common/cooper.shtml

Writing a Résumé for Susie the Screener

http://www.gsia.cmu.edu/afs/andrew/gsia/coc/student/screener.html#top
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Books

Creating Your High School Résumé by Kathryn Troutman. Jist Works, 1998.

Cyberspace Résumé Kit by Mary Nemnich. Jist Works, 1999.

Job Sleuthing: A Student’s Guide to Résumé Finesse by Suze Kroeker. Manchester House

Publishing, 1999.

Your First Résumé by Ronald Fry. Career Press, 1995.

Step-by-Step Cards

m Adding a Graphic to a Composer Web Page

m Adding Links in Netscape Composer

m Adding Sound and Movies in Netscape Composer

m Getting Started With Inspiration

m Moving Back and Forth Between Netscape Composer and Navigator

m Publishing Your Web Pages With iTools

m Searching the Internet With EdView

m Setting Up an iTools Account

m Setting Web Page Properties With Netscape Composer

m Using Netscape Composer

m Working with Tables in Netscape Composer

Templates

m Résumé Planning Map

m Skills Worksheet

m Who Am I? Worksheet

Additional Resources

m Organizing Information With Inspiration

Prerequisite Skills

To complete this project successfully, students should be able to do the following:

m create and modify concept maps in Inspiration (see the Step-by-Step Card “Getting Started

With Inspiration”)

m use EdView or other search engines to search the Internet for information relating to a

particular topic (see the Step-by-Step Card “Searching the Internet With EdView”)

m create and edit a simple word-processing document using AppleWorks
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m create a Web page with text and graphics using a Web page editor (see the Step-by-Step Cards

“Using Netscape Composer,” “Adding a Graphic to a Composer Web Page,” and “Moving Back

and Forth Between Netscape Composer and Navigator”)

Background Information

Here is some information you may find useful as you plan how to implement this project or

introduce it to your students:

m Most people put off writing a résumé until they need one for a job application. By taking the time

to put together a résumé now, students will be better prepared for the future. Even if they allow

their résumés to become outdated, revising a résumé is much simpler than creating one from

scratch.

m The two traditional résumé formats are chronological and functional.

Chronological

Name, address, phone number and/or email address

Objective (optional)

Summary of Qualifications (optional)

Education

Work Experience

JOB TITLE #1 (dates occupied) Description of responsibilities

JOB TITLE #2 (dates occupied) Description of responsibilities

JOB TITLE #3 (dates occupied) Description of responsibilities

Functional

Name, address, phone number and/or email address

Objective (optional)

Summary of Qualifications (optional)

Skills

SKILL #1

m activity that involved this skill

m activity that involved this skill

SKILL #2

m activity that involved this skill

m activity that involved this skill

Education

m A third common résumé format is called a combination format, which presents information both

ways, citing skills and work experience. The best way for students to get a sense of this format,

and the others mentioned above, is by looking at examples.
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m People seeking employment sometimes post their résumés on the Internet in résumé banks.

Online résumé banks are Web sites that allow employers to search through résumés in various

categories or by using keywords. Some résumé banks charge a fee for posting résumés. (For

some examples of résumé banks, see the Resources section.)

Options and Extension Activities

Options

m Students with a very clear career objective may want to consider a less traditional résumé format

called a “resumap.” This type of résumé places the career objective at the center of the page,

then arranges supporting skills and experience around this goal. Students can create resumaps

with Inspiration.

m Students’ résumés can be posted on the Internet as individual pages in a single class Web site,

each linked to the student’s name on the main page.

m The goal of Phase 4, publishing a résumé on the Internet, can be accomplished without the use

of a Web page editor. Students can simply add photographic images to their AppleWorks

résumés, save the résumés as HTML and JPEG files, and then post these on the Internet. (To

save résumés as HTML files in AppleWorks, choose Save As from the File menu, give the file a

name, choose HTML from the File Format pop-up menu, and then click Save. AppleWorks

creates an HTML file that retains the format of the original AppleWorks document, and creates

a separate JPEG file for any images included in the original. Both the HTML file and the JPEG

files must be posted together on the Internet.)

Extension Activities

m In addition to writing current résumés, students can write résumés for their future selves: how

they see themselves in ten years or so, after college or extensive work experience.

m You can give students more practice writing résumés by asking them to write résumés for

fictional characters they have read about during the school year, for example, Captain Ahab from

Melville’s Moby Dick.

m Have students look through the classifieds in the local newspaper and choose jobs to “apply”

for. To apply, each student writes a cover letter and, if desired, modifies their résumé to target it

towards the job. Students take turns holding mock interviews. Interviews can be filmed with a

digital camcorder, edited with iMovie, and then added to each student’s Web site. For help

using iMovie, visit the “Desktop Movies in Education” Web site.

m Assist students in arranging informational interviews with individuals whose jobs they find

interesting. Students can summarize their findings in a brief report of the interview.
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The Home-School Connection

m Students may want to ask their family members for help in remembering and documenting jobs

they have done, awards they have won, or other pertinent history or skills.

m Students can ask to see family members’ résumés.

m Students can invite their family members to view their résumés on the Internet.

This Project as a Model

In this project, students create an outline using Inspiration and then export the results to

AppleWorks. This pairing of software can be applied to other writing projects, including book

reports and summaries, research papers, and creative writing projects. Students can use Inspiration

as they would use notecards, to collect and organize their thoughts. By exporting the resulting

outline directly into AppleWorks, they get a head start on the writing process.


